Agilent N5399B HDMI Electrical Performance Compliance Test Application

Compliance Testing Notes
Contents

1 Introduction
   Installation the Application  6
   Required Equipment  10
   N5405B Test Fixture  14
   N1080B Test Fixture  16
   81150AU-EHD HDMI Ethernet Physical Layer Test Board  17

2 Calibrating the Oscilloscope and Probes
   Required Equipment for Calibration  20
   Internal Calibration  20
   Differential Socketed Probe Head Calibration  22
   SMA Probe Head Calibration  26

3 Receiver Tests
   Test 5-3, Receiver Tests  32

4 Transmitter Differential Tests
   Common Test Setup  36
   7-9: Clock Jitter (Required For All Pixel Rates)  41
   7-10: Eye Pattern - Data Lane A (Required For All Pixel Rates)  43
   7-4: Transition Time (Required For The Highest Supported Pixel Rate)  46
   7-8: Clock Duty Cycle (Required For The Highest Supported Pixel Rate)  48
   7-6: Inter-Pair Skew (Required For The Highest Supported Pixel Rate)  50
   Overshoot/Undershoot (Required For The Lowest Supported Pixel Rate) (Informative)  52

5 Transmitter Single-Ended Tests
   Test 7-2: $V_L$ Clock  56
   Test 7-7: Inter-Pair Skew  56
   Test Setup for Tests 7-2 and 7-7  56
6 Cable Eye Diagram Tests

Test 5-3, Cable Eye Diagram Tests 62

7 Jitter Separation Tests

Test Setup 65
Test 7-10, Jitter Separation Tests 71

8 HEAC Differential Signal Tests

Test ID 5-1: HEC Operating DC Voltage 74
Test ID 5-2: HEC Maximum Jitter Test (Differential Mode) 77
Test ID 5-3: HEC Rise Time/Tall Time (Differential Mode) 80
Test ID 5-4: High/Low/Center Level Voltage (Differential Mode) 84
Test ID 5-5: Cycle Time Tests 88
HEC Eye Diagram Test (Differential Mode) 91

9 HEAC Common Signal Tests

Test ID 5-6: ARC Operating DC Voltage (Common Mode) 94
Test ID HEACT 5-7: High/Low Voltage Test 97
Test ID HEACT 5-8: Rise/Fall Time Test 100
Test ID HEACT 5-9: Jitter Max/Clock Frequency Test 104
Test ID 5-19: ARC Operating DC Voltage For Receiver (Common Mode) 107

10 HEAC Single-Mode Signal Tests

Test ID 5-11: ARC Single Mode Operating DC Voltage 112
Test ID 5-12: ARC Signal Amplitude (Single Mode) 115
Test ID HEACT 5-13: Rise/Fall Time Test 118
Test ID HEACT 5-14: Jitter Max/Clock Frequency Test 121
Test ID 5-20: ARC Single Mode Operating DC Voltage (Receiver) 124

11 Error Messages

Error Messages 128
The N5399B HDMI Electrical Performance Compliance Test Application verifies compliance of an HDMI device under test (DUT) to the HDMI specifications. The application is designed to be installed on Infiniium 80000B series, 90000A series, or 9404A oscilloscopes.

- Refer to “Installation the Application” on page 6 to learn how to install the application on your oscilloscope.
- Refer to “Required Equipment” on page 10 to learn about the required test equipment.
- Refer to Chapter 2, “Calibrating the Oscilloscope and Probes” to perform the needed calibrations.
- Refer to the remaining chapters to learn about the tests setups and procedures for each test included in the application.
- Refer to the application’s online help to learn how to use the application software.

NOTE
The tests performed by the HDMI Electrical Performance Compliance Test Application are intended to provide a quick check of the electrical health of the DUT. This testing is not a replacement for an exhaustive test validation plan.

Compliance testing measurements are described in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4* document. For more information, see the HDMI web site at www.hdmi.org.
Installation the Application

Download the Application

1. On the Infiniium oscilloscope, make sure you have version A.05.40 or higher of the Infiniium oscilloscope software or version 1.21 of baseline software. Select Help> About Infiniium... from the main menu.

2. To obtain the HDMI Electrical Performance Compliance Test Application, go to Agilent website:

http://www.agilent.com/find/scope-apps-sw

3. As shown in Figure 2, type in the product name and part number: HDMI N5399B and click on the Search button.
Introduction

Installation the Application

The link for HDMI Electrical Performance Compliance Test Application will appear. Double-click on it and follow the instructions to download the application and to install it on the oscilloscope.

**Install the License Key**

1. Request a license code from Agilent by following the instructions on the Entitlement Certificate. You will need the oscilloscope’s “Option ID Number”, which you can find in the oscilloscope’s **Help > About Infiniium...** dialog box.

Most of the testing can be performed with the standard license. Before you can perform any of the HEAC tests documented in **Chapter 8**, **Chapter 9**, and **Chapter 10**, you must install the optional N5399B-003 HDMI HEAC test license.

2. After receiving your license code from Agilent, click **Utilities > Install Option License...** on the oscilloscope.

3. In the Install Option License dialog, enter your license code and click **Install License**.

4. Click **OK** in the dialog that tells you to restart the Infiniium oscilloscope application software to complete the license installation.

5. Click **Close** to close the Install Option License dialog.

6. Click **File > Exit**.

7. Restart the Infiniium oscilloscope application to complete the license installation.
Introduction

Installation the Application

Start the Application

1. From the Infiniium oscilloscope’s main menu, select Analyze > Automated Test Apps > HDMI Test.

![Location of HDMI Test Application](image1)

**Figure 3** Location of HDMI Test Application

**Figure 4** shows the HDMI Electrical Performance Compliance Test Application main window. The task flow pane, and the tabs in the main pane, show the steps required to run an automated test.

![The HDMI Test Application Window](image2)

**Figure 4** The HDMI Test Application Window
Set Up Tab

Allows you to specify connection type, type of HDMI device (device identifier), and the test fixture type.

Select Tests Tab

Click to select the tests, which are organized hierarchically. You can select all tests in a group. After tests are run, status indicators show which tests have passed, failed, or not been run, and there are indicators for the test groups.

Configure Tab

Use to enter information about the device being tested and configure test parameters (like memory depth). This information appears in the HTML report.

Connect Tab

Shows test setups for the selected tests.

Run Tests Tab

Starts the automated tests. When running multiple tests that require test setup changes, testing will pause, indicate how to change the connection, and wait for you to confirm that the connections have been changed before continuing.

Results Tab

Contains more detailed information about the tests that have been run. You can change the thresholds at which marginal or critical warnings appear.

HTML Report Tab

Shows a compliance test report that can be printed.

NOTE

When you close the HDMI application, each channel’s probe is configured as single-ended or differential depending on the last HDMI test that was run.
Required Equipment

In order to run the automated tests, you will need the following equipment and software:

- Oscilloscope, one of the following:
  - DSO90000A series Infiniium Oscilloscope,
  - DSO8000B series Infiniium Oscilloscope, or
  - DSO9404A Infiniium Oscilloscope
- ≥1 Mpts/channel oscilloscope recommended to reduce data eye pattern and jitter test times
- Provided with oscilloscope:
  - Keyboard and mouse
  - Two precision BNC-to-SMA male adapters, Agilent p/n 54855-67604
  - 50Ω BNC cable for calibrating the oscilloscope
- Optional second monitor. Recommended to view the automated test application
- N5399A HDMI Electrical Performance Compliance Test Application with license
- N5400A EZJIT Plus Jitter Analysis software license (optional)
- E2655A/B probe de-skew fixture
- Probes and test fixtures (N5405 or N1080A)
- Probe Head
  - N5380A high-BW differential SMA,
  - E2695A high-BW differential SMA, or
  - E2678A differential socketed
- 82Ω damping resistors (01130-81506) for the socketed differential probe head
- 81150A Pulse Function Arbitrary Noise Generator
- 81150AU-EHD HDMI Ethernet Physical Layer Test Board
- CEC/CDC Controller
- DC power supply

Equipment and Software for HDMI HEAC Tests

- Agilent 81150AU-EHD HDMI/HEAC Physical Test board
- CEC/CDC controller. For example, Quantum Data QD882 or Simplay CEC Explorer SL 309.
- DC power supply (+5V, 100 mA)
• Two differential InfiniiMax Probe Amplifiers (1130 series or 1160 series)
• Two 10073C probes for DC operating voltage tests
• Two E2697A 500 MHz high-impedance adapters for DC operating voltage tests
• Two E2678A differential socketed probe heads
• Two-channel 81150A function generator
• Two matched SMA cables
• Two matched SMA/BNC adapters
• N1080B-H01 HEAC TPA Fixture, plug
• Two 50Ω terminations
Table 1  Test Fixtures with Recommended Probes

<table>
<thead>
<tr>
<th>HDMI Test Fixture</th>
<th>Probe Head (Minimum Qty)</th>
<th>InfiniiMax Probe Amplifier (Minimum Qty)</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5405</td>
<td>E2678A (2) with 82Ω damping resistors (p/n 01130-81506)</td>
<td>1130 Series (2), or 1160 Series (2)</td>
</tr>
<tr>
<td>N1080A</td>
<td>N5380A or E2695A (4)</td>
<td>1130 Series (2), or 1160 Series (2)</td>
</tr>
</tbody>
</table>

InfiniiMax Probes

The E2678A differential socketed probe head and the N5380A or E2695A differential SMA probe head are recommended for use in the tests.

Figure 5  1134A InfiniiMax Probe Amplifier

Figure 6  E2678A Socketed Probe Head

Figure 7  N5380A Differential SMA Probe Head
### Table 2  Probe Head Characteristics

<table>
<thead>
<tr>
<th>Probe Head</th>
<th>Model Number</th>
<th>Differential Measurement (BW, input C, input R)</th>
<th>Single-Ended Measurement (BW, input C, input R)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differential socket</td>
<td>E2678A</td>
<td>7 GHz, 0.34 pF, 50 kΩ</td>
<td>7 GHz, 0.56 pF, 25 kΩ</td>
</tr>
<tr>
<td>High-BW differential</td>
<td>N5380A</td>
<td>12 GHz</td>
<td>12 GHz</td>
</tr>
<tr>
<td>SMA</td>
<td>E2695A</td>
<td>8 GHz</td>
<td>8 GHz</td>
</tr>
<tr>
<td>High-BW differential</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMA</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Agilent N5405B test fixture is required for all compliance tests. Figure 1 shows the top view of the N5405B test fixture and the location of the clock jumpers, data jumpers, the external Extended Display Identification Data (EDID) connector, and the 3.3V power supply connector.

To get the best probed signal fidelity, the E2678A differential socketed probe head for either the 1132A or the 1134A InfiniiMax probe amplifier is recommended. This probing solution requires two 82Ω damping resistors for calibrating and de-skewing the probes. The proper damping resistors are included with the E2678A differential socketed probe head. These resistors are only required for calibrating and de-skewing the probes and are not required for doing the tests because the N5405B HDMI test fixture has these resistors built into the board.

The EDID connector (J1) can be used for an EDID board that you have designed. J1 has the pin out shown in Figure 9.
Figure 9  EDID Connector Pin Out

Figure 10 shows the bottom view of the N5405B HDMI test fixture and the EDID Prom.

Figure 10  N5405B HDMI Test Fixture (Bottom View)
1 Introduction
N1080B Test Fixture

N1080B Test Fixture

The Agilent N1080B test fixture is used for all of the HDMI compliance tests. The N1080B HDMI test fixture is the highest bandwidth High Definition Multimedia Interface (HDMI) test point access fixture currently available in the market. This fixture delivers measurement bandwidth beyond 6 GHz, with rise time well below 100 ps. It is used to measure waveform parameters, such as rise time and data eye. The N1080B comes in three different configurations:

Option H01
A test point access adapter (TPA) with a plug which is typically used in conjunction with the low frequency board, for testing Sources and Sinks. It does not include a probing interconnect solution.

Option H02
A TPA with a receptacle, typically used in pairs for testing cables. A TPA with a plug is also required for TDR calibration.

Option H03
A the low frequency board used for various tests on both the sink and the source modules.
81150AU-EHD HDMI Ethernet Physical Layer Test Board

The Agilent 81150AU-EHD HEAC Physical Test Board is one part of the recommended test equipment for HEAC (HDMI Ethernet and Audio Return Channel) testing according to the HDMI CTS Version 1.4, Supplement 2. The HEAC Test board can be used to perform HEC (HDMI Ethernet channel) and ARC (Audio Return Channel) physical layer tests for HDMI source and sink devices. It is used for HEC/ARC Receiver and Transmitter testing. These tests are documented in Chapter 8, Chapter 9, and Chapter 10.

![Diagram of 81150AU-EHD Test Board]

**Figure 11** 81150AU-EHD Test Board
Figure 12  Jumper Definition and Settings
2

Calibrating the Oscilloscope and Probes

Required Equipment for Calibration  20
Internal Calibration  20
Differential Socketed Probe Head Calibration  22
SMA Probe Head Calibration  26

This chapter describes how to calibrate the oscilloscope and probes. Before performing HDMI tests, perform an internal calibration followed by a probe calibration.

NOTE
If the ambient temperature changes more than ±5°C Celsius from the calibration temperature, internal calibration should be performed again. The delta between the calibration temperature and the present operating temperature is shown in the Utilities>Calibration menu.

NOTE
Each probe is calibrated to the oscilloscope channel to which it is connected. Do not switch probes between channels or other oscilloscopes, or it will be necessary to calibrate them again. It is recommended that the probes are labeled with the channel on which they were calibrated.
Required Equipment for Calibration

- Keyboard and mouse for oscilloscope
- Precision BNC to SMA male adapter, Agilent p/n 54855-67604, qty = 2 (provided with the Agilent Infiniium oscilloscope).
- Calibration cable (provided with the 80000 and 90000A Series Infiniium oscilloscopes).
- BNC shorting cap (provided with the 54854A Infiniium oscilloscopes).
- E2655A/B probe de-skew fixture.
- $82 \Omega$ damping resistors (01130-81506) for the socketed differential probe head.

![BNC to SMA Adaptors (2)](image)

![SMA Calibration Cable](image)

![BNC Calibration Cable](image)

Figure 13  Accessories Provided with the Agilent Infiniium Oscilloscope

Internal Calibration

Internal Calibration is an internal diagnostic and calibration cycle for the oscilloscope. This Calibration takes about 20 minutes to complete.

1 Set up the oscilloscope with the following steps:
   a Connect the keyboard, mouse, and power cord to the rear of the oscilloscope.
   b If a second monitor is being used, connect it to the VGA connector located near the LAN port, on the rear of the oscilloscope.
   c Plug in the power cord.
   d Turn on the oscilloscope by pressing the power button located on the lower left of the front panel.
   e Allow the oscilloscope to warm up at least 30 minutes.
2 Locate BNC shorting cap, calibration cable, and two Agilent precision SMA/BNC adapters.

3 Attach one SMA adapter to the end of the calibration cable. Hand tighten snugly.

4 Attach the other SMA adapter to the other end of the calibration cable. Hand tighten snugly.

5 Click on the Utilities > Calibration menu to open the Calibration window.

![Figure 14 Accessing the Calibration Menu.](image)

6 In the Calibration dialog box, clear the Cal Memory Protect checkbox.

7 Click the Start button to begin the calibration.

8 When prompted to disconnect everything from all the inputs, click OK.

9 When prompted to connect BNC shorting cap to a specified input, install the BNC shorting cap by pressing it on the specified input BNC and turning right. Click OK after moving the BNC cap to each specified channel.

10 When prompted to connect the calibration cable with SMA adapters between the Aux Out and a specified input, install the SMA adapter by pressing it on input BNC, and hand tightening the outer ring turning right. Click OK after connecting the cable as prompted.

11 During the calibration of channel 1, you will be prompted a Calibration Options screen, as shown in Figure 15.
Calibrating the Oscilloscope and Probes

Differential Socketed Probe Head Calibration

12 Click Std + Dflt to continue the calibration, using the Factory default calibration factors.

13 When the calibration procedure is complete, you will be prompted with a Calibration Complete message window. Click the OK button to close this window.

14 Confirm that the Vertical and Trigger Calibration Status for all Channels passed.

15 Click Close to close the calibration window.

16 The internal calibration is completed.

NOTE These steps do not need to be performed every time a test is run. However, if the ambient temperature changes more than 5° Celsius from the calibration temperature, this calibration should be performed again. The delta between the calibration temperature and the present operating temperature is shown in the Utilities > Calibration menu.

Differential Socketed Probe Head Calibration

1 Connect a probe, with differential socketed probe head, to a channel.

2 Install the 82Ω resistors into the differential socketed probe head.

3 Connect the de-skew fixture to Aux Out. Clip the resistors on the de-skew fixture. These resistors are only required for probe calibration and de-skew.

4 Click Setup > Channel 1 to open the Channel Setup dialog box.
Click the Probes button in the Channel Setup dialog box, to open the Probe Setup dialog box.

Click Add Head..., and select E2678A:DF Sckt from the list of Head Type. Click OK.
2 Calibrating the Oscilloscope and Probes
   Differential Socketed Probe Head Calibration

Figure 18  Probe Setup Window

7 Click Calibrate Probe to open the Probe Calibration dialog box.

Figure 19  User Defined Probe Dialog Box

8 Select Calibrated Atten/Offset Radio.

9 Click Start Atten/Offset Calibration to open the Calibration window.
Follow the on-screen instructions.

Click Start Skew Calibration and follow the on-screen instructions. This procedure ensures that the timing skew errors between channels are minimized. For more information, refer to the De-skew and Calibration manual, which is provided with the E2655A/B De-skew Kit that came with your oscilloscope.
2 Calibrating the Oscilloscope and Probes

SMA Probe Head Calibration

1. Connect the SMA to BNC adaptor to one of the SMA connectors of the deskew fixture or SMA (f) to SMA (f) adapter.

2. Connect a short to the center SMA connector of the SMA probe head.

3. Connect the other end of the deskew fixture or SMA (f) to SMA (f) adapter to one of the SMA connectors of the SMA probe head.

4. Connect the BNC connector of the SMA to BNC adaptor to the Aux Out on the front panel of the Infiniium oscilloscope.

5. For the N5380A probe head, connect both the positive (+) side and the negative (-) side of the InfiniiMax probe amp to the GPO (SMP) connector of the SMA probe head whose path is connected to the Aux Out of the oscilloscope.

6. For the E2695A probe head, connect the positive (+) side of the InfiniiMax probe amp to the GPO (SMP) connector of the SMA probe head whose path is connected to the Aux Out of the oscilloscope. Do not connect the negative (-) side of the InfiniiMax probe amp to anything.

7. Click Setup > Channel 1 to open the Channel Setup window.
Click the Probes button in the Channel Setup window, to open the Probe Setup window.

Click Add Head..., and then select the appropriate SMA probe head from the list of Head Type. Select OK to close the dialog box.
Calibrating the Oscilloscope and Probes

SMA Probe Head Calibration

10 Click Calibrate Probe to open the Probe Calibration window.
11 Select the Calibrated Attenuation/Offset Radio Button
12 Click Start Attenuation/Offset Calibration to open the Calibration window.

13 Follow the on-screen instructions.
14 Click Start Skew Calibration and follow the on-screen instructions. This procedure ensures that the timing skew errors between channels are minimized. For more information, refer to the De-skew and Calibration...
manual, which was provided with the E2655A/B De-skew Kit that came with your oscilloscope.

**Figure 26** De-skew Connection
2 Calibrating the Oscilloscope and Probes
   SMA Probe Head Calibration
When performing receiver tests, the HDMI Electrical Performance Compliance Test Application will prompt you to make the proper connections (as shown in Figure 27). Receiver tests measurements are made using the Agilent E4887A HDMI TMDS Signal Generator as the oscilloscope trigger source.
Test 5-3, Receiver Tests

Specification Reference

Test ID 5-3: TMDS Data Eye Diagram, in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4*.

Test PASS Condition

\[ \leq 0.30 \ T_{\text{bit}}, \text{relative to the ideal Recovery Clock.} \]

The bit time \( T_{\text{bit}} \) is one tenth of the pixel time. The bit time is also referred to as one Unit Interval, or UI, in the clock jitter and eye diagram specification.

Agilent Test Procedure

1. Connect the equipment as shown in Figure 27 on page 33.
   - Connect the two probes to the oscilloscope channels. You can use any of the oscilloscope channels for the raw clock and data test points.
   - If the N5405 test fixture is used. For the clock channel, connect the probe's plus side to plus side (pin 1) of the clock channel on the test fixture and the probe's negative side to the negative side (pin 2) to the clock channel. For the TMDS data channels that you want to test, connect the probe's plus side to plus side (pin 1) of the data channel and the probe's negative side to the negative side (pin 2) to the data channel.
   - If the N1080A test fixture is used, connect the positive sides of the probe amplifiers to the positive sides of the test fixture. Ensure that when a test fixture cable is connected to an SMA probe head, that its pair is connected to the other end of the same SMA probe.
   - The data lanes and channels shown in the test setup figures are examples. You can choose any desired data lane and channel. Also, the figures show the data channel connection as well. However, it is only required if you run the tests that require a data channel and it can be any channel.

**NOTE**

Be sure to match the polarity of the differential probe to the polarity of the probed signals; otherwise, the tests will not run correctly.
Configure the ParBERT to transmit the required TMDS signal. Optionally, you may use any software that automatically configure the ParBERT.

Start the HDMI Test Application.

Click the Set Up tab.

Settings in the test application’s Set Up tab must match the physical test setups.

According to the number of channels being used, select 2 Connections or 4 Connections. You can identify the channels used for the raw clock in the Configuration tab.
6 Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.

7 Select Receiver as the Device Identifier.

Figure 28  Select Receiver

8 Click the Select Tests tab.

Figure 29  Selecting the Tests

9 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

10 Click the Run Tests tab and click Run.
4

Transmitter Differential Tests

Common Test Setup 36
7-9: Clock Jitter (Required For All Pixel Rates) 41
7-10: Eye Pattern - Data Lane A (Required For All Pixel Rates) 43
7-4: Transition Time (Required For The Highest Supported Pixel Rate) 46
7-8: Clock Duty Cycle (Required For The Highest Supported Pixel Rate) 48
7-6: Inter-Pair Skew (Required For The Highest Supported Pixel Rate) 50
Overshoot/Undershoot (Required For The Lowest Supported Pixel Rate) (Informative) 52

This chapter documents the transmitter differential tests. Before running a particular test, connect the test equipment and perform the steps listed in “Common Test Setup” on page 36.

NOTE

To reduce Jitter test time, it is recommended that the oscilloscope have 1Mpts/ch memory.
Depending on type of test fixture used, and the number of channels to be measured, connect the test equipment in one of four test setups shown in this section: Figure 30, Figure 31, Figure 32 or Figure 33.

- Connect the probes to the oscilloscope channels. You can use any of the oscilloscope channels for the raw clock and data test points.

- If the N5405 test fixture is used. For the clock channel, connect the probe’s plus side to plus side (pin 1) of the clock channel on the test fixture and the probe’s negative side to the negative side (pin 2) to the clock channel. For the TMDS data channels that you want to test, connect the probe’s plus side to plus side (pin 1) of the data channel and the probe’s negative side to the negative side (pin 2) to the data channel.

- If the N1080A test fixture is used, connect the positive sides of the probe amplifiers to the positive sides of the test fixture. Ensure that when a test fixture cable is connected to an SMA probe head, that its pair is connected to the other end of the same SMA probe.

- The data lanes and channels shown in the test setup figures are examples. You can choose any desired data lane and channel. Also, the figures show the data channel connection as well. However, it is only required if you run the tests that require a data channel and it can be any channel.

**NOTE**

Be sure to match the polarity of the differential probe to the polarity of the probed signals; otherwise, the tests will not run correctly.
Figure 30  Test Setup 1. Two Connections with N5405B
Figure 31  Test Setup 2. Four Connections with N5405B
Figure 32  Test Setup 3. Two Connections with N1080B
Figure 33  Test Setup 4. Four Connections with N1080B
7-9: Clock Jitter (Required For All Pixel Rates)

The clock jitter measurement of the raw clock is performed as a differential measurement of the rising edge of the clock signal. The clock signal from the clock recovered unit must be used as a trigger source. The clock jitter test should be performed at all pixel rates. This test is done to confirm that the Transmitter Minimized Differential Signal clock does not have excessive jitter.

Specification Reference

Test ID 7-9: TMDS, refer to Clock Jitter in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4*.

Test PASS Condition

\[ \leq 0.25 \, T_{\text{bit}}, \text{relative to the ideal Recovered Clock.} \]

The bit time \( T_{\text{bit}} \) is one tenth of the pixel time. The bit time is also referred to as one Unit Interval (UI) in the clock jitter and eye diagram specification.

Test Procedure

1. Connect the test setup as shown in “Common Test Setup” on page 36.
   - Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
   - If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
   - Connect the differential socketed probe head of one of the probes to the clock pins.
   - Connect the other differential socketed probe head to the TMDS data that you want to test.

2. Start the HDMI Test Application.

3. Click the Set Up tab as shown in Figure 34 on page 42.

Settings in the test application’s Set Up tab must match the physical test setups.

4. According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.
4 Transmitter Differential Tests
7-9: Clock Jitter (Required For All Pixel Rates)

5 Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.

6 Select Transmitter as the Device Identifier.

Figure 34  Example Settings with Two Connections and N1080A

7 Click the Select Test tab.

Figure 35  Selecting Test 7-9

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
7-10: Eye Pattern - Data Lane A (Required For All Pixel Rates)

Data eye pattern measurements are differential measurements which use the ideal recovered clock signal (defined below) as the oscilloscope trigger source. The transmitter can use any test pattern and the test ensures that the eye diagram limits given by the HDMI specification are not exceeded. The purpose of the ideal recovered clock is to give an accurate representation of link performance when used as a trigger source for the eye diagram.

\[ H(j\omega) = \frac{1}{1 + \frac{j\omega}{\omega_0}} \]

where:
\[ \omega_0 = 2\pi F_0 \]
\[ F_0 = 4.0 \text{ MHz} \]

The ideal recovered clock is equivalent to the signal that would be produced if a TMDS clock signal were input to a perfect Phase Locked Loop (PLL) with a jitter transfer function shown above. This jitter transfer function has the behavior of a low pass filter with a 20 dB/decade rolloff and a –3 dB cutoff frequency of 4 MHz. The data eye pattern test should be performed at all pixel rates.

Specification Reference

Test ID 7-10 TMDS Data Eye Diagram, refer to the High-Definition Multimedia Interface Compliance Test Specification Revision 1.4.

Test PASS Condition

Mask Test: Zero mask failures.

Data Jitter: \( \leq 0.3\ T_{bit} \)

\( T_{bit} \) (bit time) is on tenth of the pixel time. The bit time is also referred to as on Unit Interval (UI) in the jitter and eye diagram.

Test Procedure

1. Connect the test setup as shown in “Common Test Setup” on page 36.
   - Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
Transmitter Differential Tests
7-10: Eye Pattern - Data Lane A (Required For All Pixel Rates)

- If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
- Connect the differential socketed probe head of one of the probes to the clock pins.
- Connect the other differential socketed probe head to the TMDS data that you want to test.

2 Start the HDMI Test Application.
3 Click the Set Up tab as shown in Figure 34 on page 42.

**NOTE**
Settings in the test application’s Set Up tab must match the physical test setups.

4 According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.
5 Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.
6 Select Transmitter as the Device Identifier.

![Figure 36 Example Settings with Two Connections and N1080A](image)

7 Click the Select Tests tab and select the test shown in the following figure.
Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
7-4: Transition Time (Required For The Highest Supported Pixel Rate)

Rise time and fall time are differential measurements across the outputs of a differential pair. The transition is defined as the time interval between the normalized 20% and 80% amplitude levels. The transition time test should be performed at the highest pixel rate.

Specification Reference

Test ID 7-4 TMDS — T_{RISE}, T_{FALL}, refer to the High-Definition Multimedia Interface Compliance Test Specification Revision 1.4.

Test PASS Condition

75 ps ≤ Risetime/Falltime

Test Procedure

1. Connect the test setup as shown in “Common Test Setup” on page 36.
   - Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
   - If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
   - Connect the differential socketed probe head of one of the probes to the clock pins.
   - Connect the other differential socketed probe head to the TMDS data that you want to test.
2. Start the HDMI Test Application.
3. Click the Set Up tab as shown in Figure 34 on page 42.
4. According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.
5. Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.
6. Select Transmitter as the Device Identifier.

NOTE

Settings in the test application’s Set Up tab must match the physical test setups.
7-4: Transition Time (Required For The Highest Supported Pixel Rate)

Click the Select Tests tab and select the test shown in the following figure.

Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
7-8: Clock Duty Cycle (Required For The Highest Supported Pixel Rate)

The clock duty cycle measurement of the raw clock is performed as a differential measurement of the rising edge of the clock signal. The clock signal from the clock recovery unit must be used as a trigger source. The clock duty cycle test should be performed at the highest pixel rate.

Specification Reference

Test ID 7-8: TMDS Clock Duty Cycle, refer to High-Definition Multimedia Interface Compliance Test Specification Revision 1.4.

Test PASS Condition

Clock Duty Cycle (Minimum) ≥ 40%
Clock Duty Cycle (Maximum) ≤ 60%

Test Procedure

1. Connect the test setup as shown in “Common Test Setup” on page 36.
   - Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
   - If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
   - Connect the differential socketed probe head of one of the probes to the clock pins.
   - Connect the other differential socketed probe head to the TMDS data that you want to test.

2. Start the HDMI Test Application.
3. Click the Set Up tab as shown in Figure 34 on page 42.

   Settings in the test application’s Set Up tab must match the physical test setups.

4. According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.

5. Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.

6. Select Transmitter as the Device Identifier.
Click the Select Tests tab and select the test shown in the following figure.

Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
7-6: Inter-Pair Skew (Required For The Highest Supported Pixel Rate)

The transmitter skew is the time difference between the two differential signals measured at the normalized 50% crossover point. The trigger source can be either one of the differential signals. The inter-pair skew test should be performed at the highest pixel rate.

**NOTE**
Channel-to-channel de-skew must be performed on the two oscilloscope channels used for this measurement. Refer to Chapter 2, “Calibrating the Oscilloscope and Probes,” starting on page 19.

**Specification Reference**
Test ID 7-6: TMDS — Inter-Pair Skew, in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4*.

**Test PASS Condition**

\[ \leq 0.20 \, T_{pixel} \]

The pixel time \( T_{pixel} \) is the time period of the raw clock.

**Test Procedure**

1. Connect the test setup as shown in “Common Test Setup” on page 36.
2. Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
3. If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
4. Connect the differential socketed probe head of one of the probes to the clock pins.
5. Connect the other differential socketed probe head to the TMDS data that you want to test.
6. Start the HDMI Test Application.
7. Click the Set Up tab as shown in Figure 34 on page 42.

**NOTE**
Settings in the test application’s Set Up tab must match the physical test setups.
According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.

Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.

Select Transmitter as the Device Identifier.

Click the Select Tests tab and select the test shown in the following figure.

Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
Overshoot/Undershoot (Required For The Lowest Supported Pixel Rate) (Informative)

This test only applies to HDMI specification 1.2 and does not apply to the HDMI specifications 1.3 or 1.4.

Overshoot and Undershoot are differential measurements across the outputs of a differential pair. The overshoot and undershoot test should be performed at the lowest pixel rate.

Specification Reference

Test ID 7-5, TMDS Overshoot/Undershoot, in the High-Definition Multimedia Interface Compliance Test Specification Revision 1.4.

Test PASS Condition

Overshoot \( \leq 0.15 \ (2 \times V_{SWING}) \)

Undershoot \( \leq 0.25 \ (2 \times V_{SWING}) \)

Test Procedure

1. Connect the test setup as shown in “Common Test Setup” on page 36.
   - Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
   - If you are using two connections: Connect the two probes to any two channels of the oscilloscope. If you are using four connections: Connect the four probes to any four channels of the oscilloscope.
   - Connect the differential socketed probe head of one of the probes to the clock pins.
   - Connect the other differential socketed probe head to the TMDS data that you want to test.
2. Start the HDMI Test Application.
3. Click the Set Up tab as shown in Figure 34 on page 42.

NOTE

Settings in the test application’s Set Up tab must match the physical test setups.
According to the number of channels being used, Select the Channel Connection Type: 2 or 4 connections.

Select a Test Fixture Type that matches the test fixture used in the physical connection: N5405, N1080A or others.

Select Transmitter as the Device Identifier.

Click the Select Tests tab and select the test shown in the following figure.

**Figure 44**  Example Settings with Two Connections and N1080A
4 Transmitter Differential Tests
Overshoot/Undershoot (Required For The Lowest Supported Pixel Rate) (Informative)

Figure 45  Selecting Over/Undershoot Differential Tests

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
5 Transmitter Single-Ended Tests

Test 7-2: VL Clock  56
Test 7-7: Inter-Pair Skew  56
Test Setup for Tests 7-2 and 7-7  56
Agilent Test Procedure  59

This chapter documents the transmitter single-ended tests which includes the HDMI Test 7-2 TMDS $V_L$ and Test 7-7 Intra-Pair Skew. Test 7-2 TMDS $V_L$ confirms that the DC voltage level on the HDMI link is within the specified limits for the TMDS signal and should be performed at the lowest pixel rate.

The transmitter skew test is the time difference between the TMDS+ and TMDS− for the same lane. For example, the time difference between D0+ and D0−. The trigger source can be either one of the single-ended signals. The intra-pair skew test should be performed at the highest pixel rate.

Your HDMI test environment setup on the Set Up tab must match the physical connection. Channel Connection Type selection is only applicable for differential test, therefore you may leave it at default. Test Fixture Type should also match the test fixture used in the physical connection - N5405, N1080A or others.

**NOTE**

Channel-to-channel de-skew must be performed on the two oscilloscope channels used for this measurement. Refer to Chapter 2, “Calibrating the Oscilloscope and Probes,” starting on page 19.

**NOTE**

Be sure that the positive side of each probe is connected to the testing lane and that the negative side of the probe is connected to ground; otherwise, the tests will not run correctly.
Test 7-2: \( V_L \) Clock

**Specification Reference**

Test ID 7-2: TMDS – \( V_L \), in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4*.

**Test PASS Condition**

If attached Sink supports \( \leq 165 \) MHz:

\[(AV_{cc} - 600 \text{ mV}) \leq V_L \leq (AV_{cc} - 400 \text{ mV})\]

If attached Sink supports \( > 165 \) MHz:

\[(AV_{cc} - 700 \text{ mV}) \leq V_L \leq (AV_{cc} - 400 \text{ mV})\]

Test 7-7: Inter-Pair Skew

**Specification Reference**

Test ID 7-7: TMDS – Intra-Pair Skew Measurement, in the *High-Definition Multimedia Interface Compliance Test Specification Revision 1.4*.

**Test PASS Condition**

Skew value \( \leq 0.15 \times T_{bit} \)

The bit time \( T_{bit} \) is one tenth the time of the pixel time. The bit time is also referred to as one Unit Interval (UI) in the jitter and eye diagram.

Test Setup for Tests 7-2 and 7-7

You can use any of the oscilloscope channels for the raw clock and data test points. You identify the channels used for each signal in the Configuration tab of the HDMI Electrical Performance Compliance Test Application.

For probing with the N1080A HDMI test fixture, connect the positive sides of the probe amplifiers to the test fixture cable to be measured. Ensure that when a test fixture cable is connected to an SMA probe head, its pair must be connected to the next SMA probe head. Each SMA probe head must only have two connections - one to the power supply and the other to the source DUT.
The channels shown in the previous figures are just examples. You can choose any desired channel. Also note, that the figure shows the data channel connection as well. However, it is only required if you run the tests that require a data channel and it can be any channel.

**NOTE**

Connect the plus side of the probe to the plus side of the Data channel (pin 1) and the negative side of the probe to the negative side to the Data channel (pin 2).

Connect the plus side of the probe to the plus side (pin 1) of the Clock channel and the negative side of the probe to the negative side (pin 2) to the Clock channel.

---

![Diagram showing test setup](image)

**Figure 46** Test Setup 1. Two Connections with N5405 HDMI Test Fixture
Transmitter Single-Ended Tests
Test Setup for Tests 7-2 and 7-7

Figure 47  Test Setup 2. Two Connections with N1080B
Agilent Test Procedure

1. Connect the test setup as shown in “Test Setup for Tests 7-2 and 7-7” on page 56.
   - Connect the N5405 HDMI test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
   - Connect the two probes to any two channels of the oscilloscope.
   - Connect the differential socketed probe head of one of the probes to the clock pins.
   - Connect the other differential socketed probe head to the TMDS data that you want to test.

2. Start the HDMI test application.

3. Click the Set Up tab.

4. Check the Channel Connection Type according to the number of channels being used. Connect the other probes of the differential socketed probe head to the TMDS data that you want to test.

5. Select Transmitter as the Device Identifier and select the Test Fixture Type according to the test fixture being used.

6. Click the Select Tests tab and select the test shown in the following figure.

![Selecting the Tests](image)

7. Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

8. Click the Run Tests tab and click Run.
5 Transmitter Single-Ended Tests
Agilent Test Procedure
6
Cable Eye Diagram Tests

Cable eye diagram tests measurements are made using the Agilent E4887A HDMI TMDS Signal Generator as the oscilloscope trigger source.
Test 5-3, Cable Eye Diagram Tests

Specification Reference

Test ID 5-3: TMDS Clock Jitter Test, in the High-Definition Multimedia Interface Compliance Test Specification Revision 1.4.

When performing cable eye diagram tests, the HDMI Electrical Performance Compliance Test Application will prompt you to make the proper connections (as shown in Figure 49).

Test PASS Condition

≤ 0.30 T\text{\scriptsize bit} , relative to the ideal Recovery Clock.

The bit time T\text{\scriptsize bit} is one tenth of the pixel time. The bit time is also referred to as one Unit Interval, or UI, in the clock jitter and eye diagram specification.
Agilent Test Procedure

1. Connect the test setup as shown in Figure 49 for two connections. If you are using four connections, be sure to add the additional probes.

Figure 49  Test Setup Example for Two Connections

- Connect the N5405 test fixture or the N1080A test fixture to the device under test (DUT) HDMI output connector.
- Connect the two probes to any two channels of the oscilloscope.
- Connect the differential socketed probe head of one of the probes to the clock pins.
- Connect the other differential socketed probe head to the TMDS data that you want to test.
- Connect the power supply to the test fixture.
Configure the ParBERT to transmit the required TMDS signal. Optionally, you may use any software that automatically configures the ParBERT.

2 Start the HDMI test application.
3 Click the Set Up tab.
4 Check the Channel Connection Type according to the number of channels being used.
5 Select the Test Fixture Type according to the test fixture being used.
6 Select Cable as the Device Identifier.

![Select Cable](image1.png)

**Figure 50** Select Cable

7 Click the Select Tests tab.

![Selecting the Tests](image2.png)

**Figure 51** Selecting the Tests

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Jitter separation tests can only be carried out if you have the N5400A EZJIT Plus Jitter Analysis software license installed. This test is only available for transmitter differential eye pattern test and receiver equalized test.

Before you can select the Jitter Separation Measurement in the Set Up tab, the EZJIT Plus license must be installed in your oscilloscope.

Test Setup

Setup for Differential Eye Pattern Data Jitter Separation

**NOTE**

Connect the plus side of the probe to the plus side of the Data channel (pin 1) and the negative side of the probe to the negative side to the Data channel (pin 2).

Connect the plus side of the probe to the plus side (pin 1) of the Clock channel and the negative side of the probe to the negative side (pin 2) to the Clock channel.
7  Jitter Separation Tests

Test Setup

Figure 52  Test Setup 1. Two Connections with N5405B
Figure 53  Test Setup 2. Four Connections with N5405B
Jitter Separation Tests

Test Setup

Figure 54  Test Setup 3. Two Connections with N1080B
Figure 55  Test Setup 4. Four Connections with N1080B
Setup for Receiver Equalized Jitter Separation

Figure 56  Probing for Receiver Equalized Jitter Separation
Test 7-10, Jitter Separation Tests

1. Connect the test setup as shown in “Test Setup” on page 65.
2. Start the HDMI test application.
3. If the N5400A EZJIT Plus Jitter Analysis software license is installed on the oscilloscope, the Jitter Separation Measurement is automatically turned on.
4. Click the Set Up tab.
5. Check the Channel Connection Type according to the number of channels being used.
6. Select Transmitter or Receiver as Device Identifier and select the Test Fixture Type according to the test fixture being used.
7. Click the Select tab.
8. If the device is a transmitter, select 7-10 Data Jitter Separation as shown in Figure 57. If the device is a receiver, select the Receiver Equalized Jitter Separation as shown in Figure 58.
9. Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.
Click the Run Tests tab and click Run.
This chapter documents the HEAC differential signal characteristics tests. These tests are to be found in the HDMI Compliance Test Specification Supplement 2 HDMI Ethernet and Audio Return Channel (HEAC).

The test setup diagrams show the Agilent 81150AU-EHD HEAC Physical Test Board. For detailed figures of the 81150AU-EHD, refer to Figure 11 on page 17 and Figure 12 on page 18.

Before you can perform any of the HEAC tests documented in this chapter, you must install the optional N5399B-003 HDMI HEAC test license.
Test ID 5-1: HEC Operating DC Voltage

Specification Reference

Test ID HECT 5- 1: Operating DC Voltage Test

Test PASS Condition

Operating DC Voltage (Veh): 4.0V ±10%

Agilent Test Procedure

1. Connect the test setup as shown in Figure 59.

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - If testing a sink, set jumpers J200 and J210 to the "DUT=sink" position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
- If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = Ext +5V” position.
- Set jumpers J202 and J206 to the 100Ω position.

![Figure 60  81150AU-EHD Jumper Positions](image)

3 Set the DC power supply to +5V.
4 Activate HEC transmission on DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click HEC.

![Figure 61  HEC Selected](image)

7 Select the Select Tests tab and select the test.
HEAC Differential Signal Tests
Test ID 5-1: HEC Operating DC Voltage

Figure 62  Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-2: HEC Maximum Jitter Test (Differential Mode)

Specification Reference

Test ID HEACT 5-2: Jitter Max Test

Test PASS Condition

Jitter Max: 1.4 ns.

Agilent Test Procedure

1. Connect the test setup as shown in Figure 63.

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - If testing a sink, set jumpers J200 and J210 to the “DUT=sink” position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
- If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = DUT +5V” position.
- Set jumpers J202 and J206 to the 100Ω position.

Figure 64  81150AU-EHD Jumper Positions

3 Set the DC power supply to +5V.
4 Activate HEC transmission on DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click HEC.

Figure 65  HEC Selected

7 Select the Select Tests tab and select the test.
Figure 66  Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-3: HEC Rise Time/Tall Time (Differential Mode)

The following individual tests can be selected within the application’s Select Tests tab:

Test ID 5-3a: HEC Rise Time Test Top (Differential Mode)
Test ID 5-3b: HEC Fall Time Test Top (Differential Mode)
Test ID 5-3c: HEC Rise Time Test Bottom (Differential Mode)
Test ID 5-3d: HEC Fall Time Test Bottom (Differential Mode)

Specification Reference

Test ID HEACT 5-3: Rise Time/Fall Time Test

Test PASS Condition

Rise time of positive pulses signal: 3.0 ns < Tr < 5.0 ns
Fall time of positive pulses signal: 3.0 ns < Tf < 5.0 ns
Rise time of negative pulses signal: 3.0 ns < Tr < 5.0 ns
Fall time of negative pulses signal: 3.0 ns < Tf < 5.0 ns
Agilent Test Procedure

1. Connect the test setup as shown in Figure 67.

**Figure 67** Test Setup

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - If testing a sink, set jumpers J200 and J210 to the "DUT=sink" position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
   - If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = DUT +5V” position.
   - Set jumpers J202 and J206 to the 100Ω position.
3 Set the DC power supply to +5V.
4 Activate HEC transmission on DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click HEC.

7 Select the Select Tests tab and select the test.
Figure 70  Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-4: High/Low/Center Level Voltage (Differential Mode)

The following individual tests can be selected within the application’s Select Tests tab:
- Test ID 5-4a: HEC High Level Voltage (Differential Mode)
- Test ID 5-4b: HEC Low Level Voltage (Differential Mode)
- Test ID 5-4c: HEC Center Level Voltage (Differential Mode)

Specification Reference

Test ID HEACT 5-4: High/Low/Center Level Voltage Test

Test PASS Condition

- High Level Voltage (Vep): 0.2V ±10%
- Low Level Voltage (Vem): −0.2V ±10%
- Center Level Voltage (Vec): 0V ±20 mV
Agilent Test Procedure

1. Connect the test setup as shown in Figure 71.

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - If testing a sink, set jumpers J200 and J210 to the "DUT=sink" position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
   - If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = DUT +5V” position.
   - Set jumpers J202 and J206 to the 100Ω position.
HEAC Differential Signal Tests
Test ID 5-4: High/Low/Center Level Voltage (Differential Mode)

3 Set the DC power supply to +5V.
4 Activate HEC transmission on DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click HEC.

7 Select the Select Tests tab and select the test.
Figure 74  Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-5: Cycle Time Tests

The following individual tests can be selected within the application’s Select Tests tab:
Test ID 5-5a: HEC Cycle Time Top (Differential Mode)
Test ID 5-5b: HEC Cycle Time Bottom (Differential Mode)

Specification Reference

Test ID HEACT 5-5: Cycle Time Test

Test PASS Condition

Cycle Time: 8 ns ±0.125 ns

Agilent Test Procedure

1. Connect the test setup as shown in Figure 75.

![Oscilloscope Diagram]

Figure 75  Test Setup

2. On the 81150AU-EHD:
- Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
- If testing a sink, set jumpers J200 and J210 to the "DUT=sink" position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
- If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = DUT +5V" position.
- Set jumpers J202 and J206 to the 100Ω position.

**Figure 76** 81150AU-EHD Jumper Positions

3  Set the DC power supply to +5V.
4  Activate HEC transmission on DUT by using CEC/CDC controller.
5  Start the HDMI Test Application.
6  Click the Set Up tab, and select the HEAC Tests and click HEC.

**Figure 77** HEC Selected

7  Select the Select Tests tab and select the test.
8  Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9  Click the Run Tests tab and click Run.
HEC Eye Diagram Test (Differential Mode)

Specification Reference

None. This is an extra test that provides information only.

Test PASS Condition

Violation points = 0

Agilent Test Procedure

1 Connect the test setup as shown in Figure 79.

2 On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - If testing a sink, set jumpers J200 and J210 to the "DUT=sink" position. Set jumper J110 to the “DUT +5V = Ext +5V” position.
If testing a source, set jumpers J200 and J210 to the "DUT=source" position. Set jumper J110 to the “Bias +5V = DUT +5V” position.

Set jumpers J202 and J206 to the 100Ω position.

**Figure 80** 81150AU-EHD Jumper Positions

3 Set the DC power supply to +5V.

4 Activate HEC transmission on DUT by using CEC/CDC controller.

5 Start the HDMI test application.

6 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

7 Click the Run Tests tab and click Run.
HEAC Common Signal Tests

Test ID 5-6: ARC Operating DC Voltage (Common Mode) 94
Test ID HEACT 5-7: High/Low Voltage Test 97
Test ID HEACT 5-8: Rise/Fall Time Test 100
Test ID HEACT 5-9: Jitter Max/Clock Frequency Test 104
Test ID 5-19: ARC Operating DC Voltage For Receiver (Common Mode) 107

This chapter documents the HEAC common signal tests. These tests are to be found in the *HDMI Compliance Test Specification Supplement 2 HDMI Ethernet and Audio Return Channel (HEAC)*.

The test setup diagrams show the Agilent 81150AU-EHD HEAC Physical Test Board. For detailed figures of the 81150AU-EHD, refer to Figure 11 on page 17 and Figure 12 on page 18.

Before you can perform any of the HEAC tests documented in this chapter, you must install the optional N5399B-003 HDMI HEAC test license.
94

HEAC Common Signal Tests
Test ID 5-6: ARC Operating DC Voltage (Common Mode)

Test ID 5-6: ARC Operating DC Voltage (Common Mode)

Specification Reference

Test ID HEACT 5-6: Operating DC Voltage Test

Test PASS Condition

Operating DC Voltage (Veh): 4.0V ±10%

Agilent Test Procedure

1 Connect the test setup as shown in Figure 81.

Figure 81 Test Setup

2 On the 81150AU-EHD:
   • Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   • Set jumpers J200 and J210 to the "DUT=sink" position.
   • Set jumper J110 to the “DUT +5V = Ext +5V” position.
• Set jumpers J202 and J206 to the 100Ω position.

**Figure 82**  81150AU-EHD Jumper Positions

3 Set the DC power supply to +5V.
4 Activate ARC (common mode) on sink DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click ARC (Common Mode).

**Figure 83**  HEC Selected

7 Select the Select Tests tab and select the test.
Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
Test ID HEACT 5-7: High/Low Voltage Test

The following individual tests can be selected within the application’s Select Tests tab:
Test ID 5-7a: ARC High Level Voltage (Common Mode)
Test ID 5-7b: ARC Low Level Voltage (Common Mode)

Specification Reference

Test ID HEACT 5-7: High/Low Voltage Test

Test PASS Condition

High level voltage (+Vei-swing): +0.2V ±20%
Low level voltage (-Vei-swing): −0.2V ±20%

Agilent Test Procedure

1. Connect the test setup as shown in Figure 85.

![Test Setup Diagram](image-url)
HEAC Common Signal Tests
Test ID HEACT 5-7: High/Low Voltage Test

2 On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - Set jumpers J200 and J210 to the "DUT=sink" position.
   - Set jumper J110 to the “DUT +5V = Ext +5V” position.
   - Set jumpers J202 and J206 to the 100Ω position.

![TerminationResistance.png](attachment:TerminationResistance.png)

**Figure 86**  81150AU-EHD Jumper Positions

3 Set the DC power supply to +5V.

4 Activate ARC (common mode) on sink DUT by using CEC/CDC controller.

5 Click the Set Up tab, and select the HEAC Tests and click ARC (Common Mode).

![HEACSelected.png](attachment:HEACSelected.png)

**Figure 87**  HEC Selected

6 Select the Select Tests tab and select the test.
**Figure 88  Test Selected**

7 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

8 Click the Run Tests tab and click Run.
Test ID HEACT 5-8: Rise/Fall Time Test

The following individual tests can be selected within the application’s Select Tests tab:

- Test ID 5-8a: ARC Rise Time (Common Mode)
- Test ID 5-8b: ARC Fall Time (Common Mode)
- Test ID 5-8c: ARC Rise Time (Common Mode with HEC)
- Test ID 5-8d: ARC Fall Time (Common Mode with HEC)

Specification Reference

Test ID HEACT 5-8: Rise/Fall Time Test

Test PASS Condition

Rise time ($T_R$)/Fall time ($T_F$), ARC transmitted with MLT-3 (HEC signals):
Minimum 10 ns, Maximum 60 ns.

Rise time ($T_R$)/Fall time ($T_F$), ARC transmitted without MLT-3 (HEC signals): < 60 ns.
Agilent Test Procedure

1 Connect the test setup as shown in Figure 89. For detailed figures of the 81150AU-EHD, refer to Figure 11 on page 17 and Figure 12 on page 18.

![Test Setup Diagram]

**Figure 89**  Test Setup

2 On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - Set jumpers J200 and J210 to the "DUT=sink" position.
   - Set jumper J110 to the “DUT +5V = Ext +5V” position.
   - Set jumpers J202 and J206 to the 100Ω position.
3 Set the DC power supply to +5V.
4 Activate ARC (common mode) on sink DUT by using CEC/CDC controller.
5 Click the Set Up tab, and select the HEAC Tests and click ARC (Common Mode).
6 Select the Select Tests tab and select the test.
Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
Test ID HEACT 5-9: Jitter Max/Clock Frequency Test

The following individual tests can be selected within the application’s Select Tests tab:

HEACT 5-9a: ARC Jitter Test (Common Mode)
HEACT 5-9b: ARC Frequency (Common Mode)

Specification Reference

Test ID HEACT 5-9: Jitter Max/Clock Frequency Test

Test PASS Condition

Clock Frequency: 6.144 MHz ±0.1%, 5.6488 MHz ±0.1%, or 4.096 MHz ±0.1%
Maximum Jitter: 0.05 UI

Agilent Test Procedure

1. Connect the test setup as shown in Figure 93.

![Figure 93 Test Setup](image-url)
2 On the 81150AU-EHD:
   • Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   • Set jumpers J200 and J210 to the "DUT=sink" position.
   • Set jumper J110 to the “DUT +5V = Ext +5V” position.
   • Set jumpers J202 and J206 to the 100Ω position.

3 Set the DC power supply to +5V.

4 Activate ARC (common mode) on sink DUT by using CEC/CDC controller.

5 Click the Set Up tab, and select the HEAC Tests and click ARC (Common Mode).

6 Select the Select Tests tab and select the test.
HEAC Common Signal Tests
Test ID HEACT 5-9: Jitter Max/Clock Frequency Test

Figure 96  Test Selected

7 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

8 Click the Run Tests tab and click Run.
Test ID 5-19: ARC Operating DC Voltage For Receiver (Common Mode)

Specification Reference

Test ID HEACT 5-19: Common Mode Operating DC Voltage Test

Test PASS Condition

Operating DC Voltage (Veh): 4.0V ± 10%

Agilent Test Procedure

1. Connect the test setup as shown in Figure 97.

2. On the 81150AU-EHD:
   - Set jumpers J200 and J210 to the "DUT=source" position.
   - Set jumper J110 to the “Bias +5V = Ext +5V” position.
   - Set jumpers J202 and J206 to the 100Ω position.
HEAC Common Signal Tests
Test ID 5-19: ARC Operating DC Voltage For Receiver (Common Mode)

3 Set the DC power supply to +5V.
4 Activate ARC reception on Source DUT by using CEC/CDC controller.
5 Generate Audio signal in common mode signal by 81150A-002.
6 Click the Set Up tab, and select the HEAC Tests and click ARC (Common Mode).

Figure 98  81150AU-EHD Jumper Positions

7 Select the Select Tests tab and select the test.
8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.

---

**Figure 100** Test Selected

Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test. Click the Run Tests tab and click Run.
HEAC Common Signal Tests
Test ID 5-19: ARC Operating DC Voltage For Receiver (Common Mode)
10
HEAC Single-Mode Signal Tests

Test ID 5-11: ARC Single Mode Operating DC Voltage 112
Test ID 5-12: ARC Signal Amplitude (Single Mode) 115
Test ID HEACT 5-13: Rise/Fall Time Test 118
Test ID HEACT 5-14: Jitter Max/Clock Frequency Test 121
Test ID 5-20: ARC Single Mode Operating DC Voltage (Receiver) 124

This chapter documents the HEAC single-mode signal tests. These tests are to be found in the *HDMI Compliance Test Specification Supplement 2 HDMI Ethernet and Audio Return Channel (HEAC)*.

The test setup diagrams show the Agilent 81150AU-EHD HEAC Physical Test Board. For detailed figures of the 81150AU-EHD, refer to Figure 11 on page 17 and Figure 12 on page 18.

Before you can perform any of the HEAC tests documented in this chapter, you must install the optional N5399B-003 HDMI HEAC test license.
Test ID 5-11: ARC Single Mode Operating DC Voltage

Specification Reference

Test ID HEACT 5-11: Operating DC Voltage Test

Test PASS Condition

Operating DC Voltage (Vel): $0 \leq \text{Vel} \leq +5.0V$ (single-mode transmission)

Agilent Test Procedure

1. Connect the test setup as shown in Figure 101.

![Oscilloscope diagram](image)

Figure 101 Test Setup

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - Set jumpers J202 and J206 to the 110Ω position.
   - Set jumpers J200 and J210 to the "DUT=sink" position.
- Set jumper J110 to the “DUT +5V = Ext +5V” position.

Figure 102 81150AU-EHD Jumper Positions

3 Set the DC power supply to +5V.
4 Activate ARC (single mode) transmission on Sink DUT by using CEC/CDC controller.
5 Start the HDMI Test Application.
6 Click the Set Up tab, and select the HEAC Tests and click ARC (Single Mode).

Figure 103 HEC Selected

7 Select the Select Tests tab and select the test.
Figure 104 Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-12: ARC Signal Amplitude (Single Mode)

Specification Reference

Test ID HEACT 5-12: Signal Amplitude Test

Test PASS Condition

Signal amplitude (Vel swing): 0.5V ± 0.1V

Agilent Test Procedure

1. Connect the test setup as shown in Figure 105.

   ![Figure 105 Test Setup](image)

2. On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - Set jumpers J202 and J206 to the 110Ω position.
   - Set jumpers J200 and J210 to the "DUT=sink" position.
• Set jumper J110 to the “DUT +5V = Ext +5V” position.

**Figure 106** 81150AU-EHD Jumper Positions

3 Activate ARC (single mode) transmission on Sink DUT by using CEC/CDC controller.

4 Start the HDMI Test Application.

5 Click the Set Up tab, and select the HEAC Tests and click ARC (Single Mode).

**Figure 107** HEC Selected

6 Select the Select Tests tab and select the test.
7 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

8 Click the Run Tests tab and click Run.
**Test ID HEACT 5-13: Rise/Fall Time Test**

The following individual tests can be selected within the application’s Select Tests tab:

- Test 5-13a: ARC Rise Time (Single Mode)
- Test 5-13b: ARC Fall Time (Single Mode)

**Specification Reference**

Test ID HEACT 5-13: Rise/Fall Time Test

**Test PASS Condition**

Rise time (Tr)/Fall time Tf: Max 60 ns

**Agilent Test Procedure**

1. Connect the test setup as shown in Figure 109.

![Figure 109 Test Setup](image)
2 On the 81150AU-EHD:
- Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
- Set jumpers J202 and J206 to the 110Ω position.
- Set jumpers J200 and J210 to the "DUT=sink" position.
- Set jumper J110 to the “DUT +5V = Ext +5V” position.

![Figure 110 81150AU-EHD Jumper Positions](image)

3 Set the DC power supply to +5V.

4 Activate ARC (single mode) transmission on Sink DUT by using CEC/CDC controller.

5 Start the HDMI Test Application.

6 Click the Set Up tab, and select the HEAC Tests and click ARC (Single Mode).

![Figure 111 HEC Selected](image)

7 Select the Select Tests tab and select the test.
10 HEAC Single-Mode Signal Tests
Test ID HEACT 5-13: Rise/Fall Time Test

Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

Click the Run Tests tab and click Run.
Test ID HEACT 5-14: Jitter Max/Clock Frequency Test

The following individual tests can be selected within the application’s Select Tests tab:
Test 5-14a: ARC Jitter Test (Single Mode)
Test 5-14b: ARC Clock Test (Single Mode)

Specification Reference

Test ID HEACT 5-14: Jitter Max/Clock Frequency Test

Test PASS Condition

Clock Frequenc: 6.144 MHz ±0.1%, 5.6488 MHz ±0.1%. or 4.096 MHz ±0.1%. Jitter Max: 0.05 UI

Agilent Test Procedure

1. Connect the test setup as shown in Figure 113.
2 On the 81150AU-EHD:
   - Place 50Ω terminations on the Signal + (J201) and Signal – (J209) SMA connectors.
   - Set jumpers J202 and J206 to the 110Ω position.
   - Set jumpers J200 and J210 to the "DUT=sink" position.
   - Set jumper J110 to the “DUT +5V = Ext +5V” position.

![81150AU-EHD Jumper Positions](image)

3 Set the DC power supply to +5V.

4 Activate ARC (single mode) transmission on sink DUT by using CEC/CDC controller.

5 Start the HDMI Test Application.

6 Click the Set Up tab, and select the HEAC Tests and click ARC (Single Mode).

![HEC Selected](image)

7 Select the Select Tests tab and select the test.
Figure 116  Test Selected

8 Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options gain more insight into the device under test.

9 Click the Run Tests tab and click Run.
Test ID 5-20: ARC Single Mode Operating DC Voltage (Receiver)

Specification Reference

Test ID HEACT 5-20: Single Mode Operating DC Voltage Test

Test PASS Condition

Operating DC Voltage (Vel): $0 \leq \text{Vel} \leq +5.0V$ (single-mode transmission)

Agilent Test Procedure

1. Connect the test setup as shown in Figure 117.

![Figure 117 Test Setup](image)

2. On the 81150AU-EHD, set:
   - Set jumpers J202 and J206 to the 110Ω position.
   - Set jumpers J200 and J210 to the of "DUT=source" position.
   - Set jumper J110 to the “Bias +5V = Ext +5V” position.
3 Set the DC power supply to +5V.
4 Activate ARC reception on Source DUT by using CEC/CDC controller.
5 Generate Audio signal in single mode signal by 81150A-002
6 Start the HDMI Test Application.
7 Click the Set Up tab, and select the HEAC Tests and click ARC (Single Mode).

8 Select the Select Tests tab and select the test.
Click the Configure tab. Select Compliance to check the device under test for compliance to the standard. Or, click Debug and configure various test options to gain more insight into the device under test.

10 Click the Run Tests tab and click Run.
11 Error Messages

Cannot find the sync pattern 128
File Not Selected 128
HDMI Test - Warning 128
Invalid Pattern 129
Maximum Tries Reached 129
Measurement Threshold 130
No Channel Selected 130
No Edge Available 130
No Option Selected 130
No Pattern Triggered 130
No Signal Triggered 130
Unstable Clock Frequency 130
Wrong Clock Frequency 131
Wrong Connection Settings 131
Wrong File Selected 131
Wrong Pattern Triggered 131

When performing HDMI tests, error message dialog boxes can occur due to improper configuration settings. This section describes the possible causes of the errors and the solution to the problem.

Figure 121 Example Error Dialog Box
Error Messages

**Cannot find the sync pattern**

The Cannot find the sync pattern error appears when:

- The Additional Sync Pattern was not found in the signal being tested. Change the Additional Sync Pattern in the Configure tab or make sure that the pattern is in the signal.

- The System cannot trigger based on HDMI’s sync pattern. Ensure that valid HDMI pattern is used on the DUT. Enter specific sync pattern through configuration tab.

**File Not Selected**

The File Not Selected error appears when no file was selected for Manual Equalizer Coefficient Value during manual mode selection. Select a coefficient file to during this process. Select a coefficient file to during this process.

**HDMI Test - Warning**

This error appears when one of the following configuration errors is encountered.

- There is no differential probe connected to the selected channel. In the Configure tab select the channel to be the one where the probe is connected or connect the probe to the selected channel.

- The probe is uncalibrated. Calibrate and de-skew the probe.

- The wrong probe head is selected. HDMI testing requires the differential socketed probe head (E2678A). Therefore, select E2678A probe head in the oscilloscope’s probe dialog box as shown in Figure 122.
Invalid Pattern

The Invalid Pattern error appears when the pattern entered during Custom Pattern Triggering mode for Inter-Pair Skew is invalid. Enter a valid pattern for this Inter-Pair Skew mode.

Maximum Tries Reached

The Maximum Tries Reached error appears when the maximum number of trials is made for Jitter Separation test. So, no valid measurement is made. Check the connection to ensure that the DUT outputs a valid signal.
Measurement Threshold

The Wrong Measurement Threshold error appears when the Measurement Threshold selected for Rise Time and Fall Time has exceeded the waveforms’ threshold. So, no measurement can be made. Set a proper Measurement Threshold.

No Channel Selected

The No Channel Selected error appears when There is no channel selected during the Probe Offset Calibration. A channel must be selected before proceeding with Probe Offset Calibration.

No Edge Available

The No Edge Available error appears when no edge is available for measurement during Eye Diagram test. Check for mask at other location.

No Option Selected

The No option selected error dialog box appears when there is no option selected during the Probe Offset Calibration. An option must be selected before proceeding with Probe Offset Calibration.

No Pattern Triggered

The No Pattern Triggered appears when No signal is triggered on the respective channel. Check the connection settings.

No Signal Triggered

The No Signal Triggered error appears when there is no signal triggered or acquired on either channel. Check the connection to ensure that the DUT channel outputs a valid HDMI signal.

Unstable Clock Frequency

The Unstable Clock Frequency error appears when one of the following conditions occurs.

- The probe is not connected to the clock lane.
  Connect the probe designated as the clock lane to the clock test points.
- The device under test is not producing a valid HDMI clock waveform.
Wrong Clock Frequency

The Wrong Clock Frequency error appears when the selected Software Transition Time Converter (TTC) mode conflicts with the current measured Frequency. Select proper TTC mode that corresponds to the current Frequency.

Wrong Connection Settings

The Wrong Connection Settings error appears when the positive side of the probe is connected to ground and the negative side of the probe is connected to the signal. Reverse the probe connections.

Wrong File Selected

The Wrong File Selected error appears when the selected file is not in *.EQU format. Select *.EQU file only for Equalization and Software TTC. It also occurs when the wrong file format is selected for Equalization and Software TTC mode. Only *.EQU files can be used for Equalization and Software TTC mode.

Wrong Pattern Triggered

The Wrong Pattern Triggered error appears when the patterns triggered at both Channel for Inter-Pair Skew did not match. Either one of the channels's pattern could either be wrong or does not match the other pattern. Check the connection of both Channels. Both pattern triggered on both channels for inter-pair skew must match.
## Index

### B
- BNC shorting cap, 20
- BNC to SMA male adapter, 10, 20

### C
- calibrating the oscilloscope, 19
- calibration cable, 10, 20
- configure, 9
- connect, 9

### D
- de-skewing, 14

### E
- error messages, 127

### H
- HTML report, 9

### I
- internal calibration, 20

### J
- jitter tests, 35

### K
- keyboard, 20

### L
- license key, installing, 7

### M
- mouse, 20

### N
- N5399A HDMI Electrical Performance Compliance Test Application, 5

### P
- precision 3.5 mm BNC to SMA male adapter, 10, 20
- probe calibration, 22, 26
- probing for cable eye diagram tests, 62
- probing for clock jitter differential tests, 36

### R
- report, 9
- required equipment and software, 10
- required equipment for calibration, 20
- results, 9
- run tests, 9
- running clock duty cycle test, 48
- running clock jitter test, 41
- running data eye pattern tests, 43
- running jitter separation tests, 71

### S
- select tests, 9
- starting the HDMI automated test application, 8

### T
- Test ID 5-3 TMDS Clock Jitter Test, 62
- Test ID 5-3 TMDS Data Eye Diagram, 32
- Test ID 7-10 Data Jitter Separation, 71
- Test ID 7-10 TMDS Data Eye Diagram, 43
- Test ID 7-2 TMDS — VL, 56
- Test ID 7-4 TMDS, 46
- Test ID 7-5 TMDS Overshoot/Undershoot, 52
- Test ID 7-6 TMDS — Inter-Pair Skew, 50
- Test ID 7-7 TMDS — Intra-Pair Skew, 56
- Test ID 7-8 TMDS Clock Duty Cycle, 48
- Test ID 7-9 TMDS, 41
- Test ID HEACT 5-1 Operating DC Voltage Test, 74
- Test ID HEACT 5-11 Operating DC Voltage Test, 112
- Test ID HEACT 5-12 Signal Amplitude Test, 115
- Test ID HEACT 5-13 Rise/Fall Time Test, 118
- Test ID HEACT 5-14 Jitter Max/Clock Frequency Test, 121
- Test ID HEACT 5-19 Common Mode Operating DC Voltage Test, 107
- Test ID HEACT 5-2 Jitter Max Test, 77
- Test ID HEACT 5-20 Single Mode Operating DC Voltage Test, 124

Test ID HEACT 5-3 Rise Time/Fall Time Test, 80
Test ID HEACT 5-4 High/Low/Center Level Voltage Test, 84
Test ID HEACT 5-5 Cycle Time Test, 88
Test ID HEACT 5-6 Operating DC Voltage Test, 94
Test ID HEACT 5-7 High/Low Voltage Test, 97
Test ID HEACT 5-8 Rise/Fall Time Test, 100
Test ID HEACT 5-9 Jitter Max/Clock Frequency Test, 104